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Welcome to the FFI GIS module 
This User's Guide covers installation and operation of the FFI GIS module, which is a 
component of the FFI ecological monitoring utilities toolset. 

FFI GIS is accessible as a toolbar in ArcMap 9.2, and requires installation of FFI and ArcGIS 
on your desktop computer. The FFI GIS module provides support in developing project 
units and candidate plots. A custom tool within the module lets you overlay different 
types of GIS layers to identify the geographical area occupied by sample populations. 
FFI GIS also allows you to randomly or selectively choose sample points. In addition, the 
module includes tools to identify severity thresholds in dNBR layers for CBI sampling. 

About FFI 
FFI version 1.02 is an integration of FEAT and FIREMON, two respected, science-based 
programs used for fire effects monitoring on public lands. Developed jointly by the 
National Park Service and the Bureau of Reclamation, FFI was designed as a 
comprehensive, database-driven framework that organizes sampling protocols, stores 
field data, and provides analysis tools for vegetation sampling and monitoring programs. 
FFI is designed for people with vegetation sampling experience who need a way to 
organize their sampling data so that it can be readily accessed.    

The goal of FFI is to act as a robust monitoring tool that can be used across public 
agencies, as well as private entities, to consistently describe ecological systems. It 
incorporates components necessary to conduct a successful monitoring program, 
including an integral database, analysis and reporting tools, a protocol manager that 
enables users to develop their own sampling methods when needed, as well as FFI GIS, 
the spatial component. For more information about FFI, visit the on-line information page 
at frames.nbii.gov/ffi. 

About the User's Guide
 There are three separate User's Guides : 

o FFI (main application) 

o Protocol Manager 

o GIS Module 

Each User's Guide is available in three formats: on-line, as desktop help, and in PDF 
format. It will be updated as FFI is revised, and updates will be announced to the user 
community via the on-line FFI information page at frames.nbii.gov/ffi. 

See also: Roadmap to the User's Guide

Links  
o On-line (missing or bad snippet) information at FRAMES 

o On-line users community at Google Groups 

There are three separate User's Guides available at FRAMES and on-line:  
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http://frames.nbii.gov/ffi
http://frames.nbii.gov/ffi/help/ffi/Default.htm
http://frames.nbii.gov/ffi/help/pm/Default.htm
http://frames.nbii.gov/ffi/help/gis/Default.htm
http://frames.nbii.gov/ffi
http://frames.nbii.gov/ffi
http://groups.google.com/group/FFIemu?hl=en
http://frames.nbii.gov/ffi


o  (missing or bad snippet) (main application) 

o Protocol Manager 

o GIS Module 
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http://frames.nbii.gov/ffi/help/ffi/Default.htm
http://frames.nbii.gov/ffi/help/pm/Default.htm
http://frames.nbii.gov/ffi/help/gis/Default.htm


User's Guide roadmap 
Follow the links to reach the components of the User's Guide: 

o Getting help 

o Installation 

o FFI GIS basics 

o Using the FFI GIS toolbar in ArcMap 

o Using the FFI GIS toolbar for CBI 
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Getting additional help 
If you need help beyond the information provided in this User's Guide, visit the on-line FFI 
information page at frames.nbii.gov/ffi. This FRAMES page provides: 

o Information about the FFI ecological monitoring utilities. 

o Links to FFI documentation and training information. 

o Links to other FRAMES pages. 

o Calendar of upcoming events. 

o Contact information for members of the FFI team. 

Also visit the on-line users community at Google Groups

Using ArcGIS desktop help  
Further information on using ESRI ArcGIS is available both on-line and in book format. 
Refer first to Chapter 1 in the Using ArcMap handbook or open the comprehensive 
ArcGIS Desktop Help file at C:\Program Files\ArcGIS\Help.  

 

NOTE: ESRI offers a two-part on-line training course, and other tutorials are available 
from ESRI’s virtual campus. If you would like additional ArcGIS training, visit ESRI at 
campus.esri.com or visit www.esri.com for seminar opportunities. The two-part training 
course is available to National Park Service employees at no charge. 
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http://frames.nbii.gov/ffi
http://groups.google.com/group/FFIemu?hl=en
http://campus.esri.com/
http://www.esri.com/


For more help with Spatial Analyst and its functions, including manipulation of GRID data, 
go to Extensions > Spatial Analyst>Spatial Analyst functional reference in ArcGIS Desktop 
Help. Like ArcGIS Help, this reference contains an index and search capabilities. 

 

 8



Installation 
This section outlines the three steps in installing the FFI GIS toolbar in ArcMap. 

o Installing FFI GIS 

o Starting ArcMap 

o Loading the FFI GIS toolbar  
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Installing FFI GIS 
FFI GIS is an optional FFI module, designed to be used as a toolbar within ArcMap 9.2.   

Required software 
o FFI version 1.02 

o ESRI ArcGIS 9.2 with: 

o  Service Pack 2 or later 

o ESRI .NET support feature 

o ESRI Spatial Analyst 9.2 with Service Pack 2 or later 

NOTE: If you do not have Service Pack 2, visit the ESRI Web site. 

Installation procedure 
To install FFI GIS: 

1. Download the FFI GIS toolbar installer to your desktop. 

2. Ensure that all required software is installed. 

3. Double-click the FFI_GIS .exe icon on your desktop and follow the instructions. This 
will add the FFI GIS toolbar to ArcMap. 

4. Open ArcMap. 

5. To ensure that ESRI Spatial Analyst is installed and turned on, click the Tools pull-
down menu. 

6. Select Extensions. 
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7. In the Extensions list, check the box next to Spatial Analyst and click Close. 

 
8. Close ArcMap and any other ArcGIS modules that might be open. 

All of the Spatial Analyst functions should now be available for use. If Spatial Analyst does 
not appear in the list of extensions, install it from the ESRI CD. 
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Next:  Starting ArcMap
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Starting ArcMap 
After you have installed the FFI GIS toolbar, navigate through Start > Programs > ArcGIS > 
ArcMap. 

You will be prompted with the following window:  

 
o If you have not used the FFI GIS toolbar before, select A new empty map. 

o If you have already created a map for use with FFI, select An existing map and 
browse to the directory where the map is saved. 

NOTE: See Storing maps and map data for information on where to file maps and 
data sources. 

Next:  Loading the FFI GIS toolbar in ArcMap
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Loading the FFI GIS toolbar 
When ArcMap opens, look for the FFI GIS toolbar. The toolbar may be docked with the 
other toolbars at the top of the ArcMap window, or it may be floating on your screen. 

 
If you do not see the toolbar, right-click anywhere in the toolbar area at the top of the 
ArcMap window. In the list that opens, select FFI GIS Toolbar. 

 
Drag the toolbar and dock it with the other toolbars if desired. 
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NOTE: If the toolbar does not appear in the list of extensions, it has not yet been 
installed. Make sure that the Spatial Analyst Extension is installed and turned on before 
attempting to install the FFI GIS Toolbar.  

Next: FFI GIS basics
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FFI GIS basics 
This section provides a framework for using maps and data with the FFI GIS toolbar. 

o Storing maps and map data 

o Connecting your map 

o Adding data to your map 

o Setting project parameters 

o Converting layers to GRID format 
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Storing maps and map data  
GIS datasets can be used by FFI GIS wherever they are stored on your system. You do not 
need to copy datasets to a special folder. You may wish to create a folder structure as 
pictured below for storing maps and datasets that you create as you use the tool. This 
suggested structure provides a folder for the project unit raster files that you will 
generate. 

 
To save your map in the recommended project unit folder, go to File > Save As and 
browse to the folder: FFI\AdminUnit\Applications\Maps. 

o The folder FFI\AdminUnit\Datasources\Shapefiles can be used to store vector 
data.  

o The folder FFI\AdminUnit\Datasources\Grids can be used to store raster data.   

Next: Connecting your map
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Connecting your map 
In order to use the tools in the FFI GIS toolbar (with the exception of the Adjust dNBR 
Range tool), you must connect your map to your SQL Server database. Follow the steps 
below to connect your map. 

1. Open the map you wish to work with. 

2. Ensure that Spatial Analyst is turned on. 

3. Click Connect in the FFI GIS toolbar and connect to your SQL Server database. 

 

NOTE: You will need to connect each time you open your map. 

You can connect remotely to an FFI server from a computer that is running ArcGIS and 
FFI GIS. Your maps and data do not need to be stored on the server and neither ArcGIS 
nor FFI GIS need to be installed on the server. 
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Next:  Adding GIS data to your map
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Adding GIS data to your map 
To add data to your map: 

1. In ArcMap, select File > Add Data. 

 
2. In the Add Data dialog box, navigate to the location where the GIS data for the 

administrative unit is stored. 

NOTE. This data can reside on a local computer or on a server. However, if you plan to 
use the FFI GIS toolbar on a computer that is not connected to your network, the GIS 
data must reside on the local hard drive. 

Below is a partial list of layers that are typically included. See your GIS specialist to 
determine what data layers are available for your area. 

o  Park Boundary  

o  DRGs/DOQs 1:100,000 or 1:24,000  

o  Elevation  

o  Slope  

o  Park Facilities  

o  Existing Plot Locations  
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o  Vegetation  

o  Available Fuels  

o  Roads  

o  Streams  

o  Surface Hydrology  

o  Burn History  

NOTE: Be sure to create a consistent file structure to contain your maps and GIS data. 
See Storing maps and map data for a suggested file structure. 

Next:  Setting project parameters
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Setting project parameters 
It is best to use map data that is all in the same projection. Consult with your GIS 
specialist to determine what projection your data is in. The projection of your map 
should be the same as the projection of your recorded plot location coordinates.  

To set the projection of your map, right-click on Layers and select Properties. 

 
This will open the Data Frame Properties dialog box. Select the Coordinate System tab. 
This tab will display the current coordinate system of your map. This should be the same 
coordinate system that you use to record your FFI plot locations. If it is not, you will need 
to reset the coordinate system of your map. 
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To change the coordinate system of your map, see your GIS specialist. If the coordinate 
system that you use for plot locations is different from the coordinate system used by your 
park for your GIS layers, see your GIS specialist.  

Next: Converting layers to GRID format
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Converting layers to GRID format 
Input layers to the project unit form must be in ESRI GRID raster format. These include any 
layers that you might use to define your project unit, such as vegetation, fuels, elevation, 
slope, etc. Layers such as elevation and slope are normally in GRID format already. 
Check layers that will be used to define monitoring units to determine whether they are 
in GRID format. Use ArcCatalog, rather than Explorer, to manage (move or copy) spatial 
data. 

Double-click on a layer to bring up the Layer Properties dialog box. Select the Source 
tab. Under Data Type it will read Shapefile Feature Class if your data is a shapefile. 
Shapefiles need to be converted to GRID format for use with the Monitoring Unit form. If 
your data is already in GRID format, it will read File System Raster under Data Type. These 
files are already in GRID format and do not need to be converted.  

 
To convert layers to GRID format: 

1. Set the Spatial Analyst options. 

o Select Options from the Spatial Analyst drop-down.  

o Under the General tab, click Browse to select a working directory. This is the 
directory where grid data will be stored. You may want to discuss data storage 
with your GIS specialist. A good choice for the working directory is the folder 
FFI_Data\ Admin\Datasources\Grids. 
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o You can leave the rest of the items under the General tab as their default values.  

o Under the Extent tab, click on the Analysis Extent drop-down menu. Select a layer 
that covers your entire administrative unit. The administrative unit boundary layer is 
a good choice. The other items under this tab can be left as their default values.  

o Under the Cell Size tab, set the cell size to an appropriate value. Consult with your 
GIS specialist if you are not sure. This value should probably be set to the smallest 
cell size found in your various base datasets. Ten meters is a common choice. The 
other items under this tab can be left as their default values.  

2. Select the Convert option from the Spatial Analyst drop-down. 

3. Select Features to Raster. 

o In the dialog box, select the file you want to convert to GRID in the Input features 
box.  

o In the Field drop-down, select the field that you would like to see represented in 
the output GRID. For example, for vegetation this would be a field which identifies 
the vegetation type. For fuels this would be the field that identifies the fuel type. 

o The Output Cell Size should already be set, since you defined it in the Options 
dialog.  

o The output raster location will be set to the location you selected for the Working 
Directory in the Options dialog. If needed, you can change it now.  
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4. Click OK to initiate the conversion. Depending on the size of the file, this could take 

several minutes. 

  Next: Using the FFI GIS toolbar
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Using the FFI GIS toolbar 
This section outlines the functions included in the FFI GIS toolbar. 

o Adding a plot layer 

o Making a project unit 

o Querying plots 

o Making candidate plots 

o Adjusting dNBR range 

o Displaying a tree map 
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Adding a plot layer 
This menu item adds a plot layer to the map. You can add a plot layer for a single 
project unit at a time; however, you can add a layer for each project unit and symbolize 
each differently in order to view the plots separately. Plot layers can be saved with the 
map but will not be 'live', and will not always display the current plots. 

Plot locations are based on the X, Y coordinates in your FFI database. These must be in 
the same projection as your map. When the map is re-opened, this layer displays without 
the need to click Connect. 

 
You can add labels to the layer. 

Converting a layer to a shapefile 
Converting a layer to a shapefile can be useful if you need to share your plot location 
data with someone else in another park or division, or to use your plot location data in a 
different map. 

To convert a layer: 

1. Right-click the plots layer in the tree view and select Data > Export Data.  
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2. This will bring up the Export Data dialog box. Leave the Export drop-down at the 

default ‘All features’. If you have set the projection of your map, as described in the 
Projection Parameters section, set the Use the same coordinate system as: toggle 
to the data frame. If desired, rename the shapefile in the Output shapefile or 
feature class box. 

 29



 

You should change the coordinate system toggle if you set the projection of the data 
frame to the same projection as your plot and map data as described in the 
Projection Parameters section. If you didn’t set the projection of your data frame, use 
the default value this layer’s source data.  This will leave your exported shapefile 
without a projection defined. See your GIS specialist to define the projection.  

Exporting the layer to a table 
It may be useful to export the layer to a table. This will give you a list of the X, Y 
coordinate values for each plot as well as information on plot type, aspect, azimuth, etc. 

To export the layer: 

1. Right-click the layer in the tree view. 

2. Select Open Attribute Table. 

3. When the table opens, select Export from the Options drop-down (at the bottom 
of the table). 
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Next: Making a project unit
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Making a project unit 
This section describes how to create spatial definitions (raster layers) for new and existing 
project units. It covers: 

o Identifying the project unit 

o Range of values criteria 

o Discrete values criteria 

o Other considerations when defining project units 

Identifying the project unit 
The Make a Project Unit menu item in the FFI GIS toolbar opens a form for creating spatial 
definitions (raster layers) for new and existing project units. Project units do not need to 
be spatially defined, but defining them can help with plot management and allows you 
to use the FFI GIS toolbar to create random points for new plot generation. Project units 
are spatially defined based on the monitoring unit metadata. Common characteristics 
used to define a project unit might be vegetation type, distance from roads or water, 
elevation, etc. 

Spatially defining an existing project unit 
See the following example for a step-by-step description of spatially defining an existing 
project unit.  

Choose the project unit to be spatially defined using the Existing drop-down list. (You can 
also click New to create a new project unit.) 

 
If you select a project unit that is already spatially defined, a dialog box will tell you 
where you can locate the current GRID. 
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The Make a Project Unit form will display the previous creation code at the bottom of the 
form for reference, but you can create a new spatial definition with any parameters you 
choose. 

 
Next: Range of values criteria

Range of values criteria 
You can define the project unit based on a range of values.  

 
1. First, select the raster layer you would like to use to define your monitoring type 

from the list under Choose Layer and Field. This example uses Slope Degree as the 
raster layer.  

2. Choose a field under the Fields list to define your project unit. Select the field that 
contains the information that you are using to define the project unit. In this case, 
the slope data is stored in the Value field.   
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3. Set a range of values to be included in your project unit. You can select values 
from the Min and Max drop-down lists or type your own values directly into the Min 
and Max boxes. In this example, the FOREST project unit should only include areas 
below 35 degrees slope, so the range is set from a minimum of 0 m to a maximum 
of 35 m.    

4. After defining the range, click Add, and the range you defined will appear in the 
list, as shown in the example.  

Next: Discrete values criteria

Discrete values criteria 
You can also define the project unit based on a discrete value or set of values.  

 
1. First, select the raster layer you would like to use to define your monitoring type 

from the pull-down list under Choose Layer and Field. In the example below, 
vegetation is selected as the raster layer.  

2. Choose a field under the Fields list to define your project unit. In the example, the 
vegetation layer has a general vegetation field, so G_COVER is selected.  

3. Select the specific values that you would like to include in your monitoring type 
from the Value drop-down under Include Discrete Values for Layer. In the 
example, both Ponderosa and Burned Ponderosa are selected.  

4. Click Add and your selection will appear in the list, as shown in the example.  

Make sure that your values for a layer appear on only one line in the data grid. This 
example means "give me all the areas that are Ponderosa OR Burned Ponderosa". If 
the two values appeared on separate rows on the data grid, the meaning would be 
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"give me all the areas that are Ponderosa AND Burned Ponderosa at the same time", 
which is incorrect because any given area in the raster layer can have only one 
value. 

 In this example, the FOREST project unit has been defined to include all areas with 
a Ponderosa or Burned Ponderosa vegetation type and have a slope of less than 35 
degrees. Areas in pink represent the project unit.  

 
5. Click Save As and name the new raster layer. The calculations take a while to run, 

and then the new raster layer is added to the map. 

 See also Other considerations when defining project units 

Considerations when defining project units 
It is important to note that the criteria you select in the Make a project unit form are 
additive. For example, you might want to make a new project unit that includes low- and 
mid-elevation short-needle pine. These are different vegetation types, and are coded as 
14 and 16 in the Vegetation GRID layer. To include them both in the project unit, you 
must select them both from the Value drop-down list under Include Discrete Values for 
Layer. Press Add only after both values have been selected. 
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If you select each value separately and add it as a separate line to the table, as shown 
below, you will receive an error message and no raster layer will be generated. This is 
because an area cannot include both low-elevation short-needle pine and mid-
elevation short-needle pine. 
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If you specify two values that don’t overlap as your parameters for defining the project 
unit, you will see this error message: 

 
All raster inputs to the Make a Project Unit form MUST be in the same projection.  

See also: Query plots
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Querying plots 
This section describes how to work with plot selection. It covers: 

o Choosing a project unit 

o Spatially selecting plots 

o Assigning selected plots to a project unit 

o Sending selected plots to FFI Query 

Selecting the project unit 
The Query Plots menu item in the FFI GIS toolbar opens a form that allows you to work 
with plot selection. When the form opens, a copy of the plots layer called Plots_Temp 
appears in the map. This layer is static (that is, if you create a new plot in FFI, it will not 
show up in Plots_Temp) and will disappear when you close the Query Plots form. Unlike 
the Plots layer, you can make selections in this layer while the form is open. 

In the Project Unit drop-down, select the project unit to associate plots with.  

 

NOTE: If you select a project unit that has not been spatially defined (see previous 
section), the Spatially Select Plots in Project Unit button will be grayed out.  However, 
the Assign Selected Plot to Project Unit and Send Selected Plots to Query Builder 
buttons will function.  

Removing unneeded layers 

Each time that you select a project unit in this way, a raster layer for the spatial definition 
will be added to your map. You might want to remove these layers from your map when 
you are done with them. Right-click the layer in the tree view and select Remove. 
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Next: Spatially select plots

Spatially selecting plots in the project unit 
Click Spatially Select Plots in Project Unit to select plots in the Plots_Temp layer that fall 
within the raster layer of the selected project unit.  To do this, the project unit must be 
spatially defined.  

As shown in the example, three plots were selected in the FOREST project unit. Click OK 
to close the window. 
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Next: Assign selected plots to project unit

Assigning selected plots to a project unit 
The Assign Selected Plot to Project Unit button assigns the selected macro plots to the 
project unit, but does not give any visual feedback. You can use this function as an 
alternative to using the Macro Plot Builder in FFI.  

Next: Send selected plots to FFI Query

Sending selected plots to FFI Query  
The Send Selected Plots to Query Builder function lets you analyze your selected macro 
plots using FFI Query. When you select this option, FFI GIS creates a new project unit that 
contains the plots that you have selected. 

1. Select the desired macro plots using the Spatially Select Plots in Project Unit button 
or the Select tool in ArcMap. If you use the Select tool, make sure to leave the 
Query Plots form open during selection. 

2. Once you have selected the plots, click Send Selected Plots to Query Builder.  

3. The New Project Unit window opens. Enter the project unit name and additional 
information, and click OK. 
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4. A Success window opens. Click OK. 

 
5. Next, open FFI and navigate to Query or Reports and Analysis to work with the 

plots in the newly created project unit.  

Next: Making candidate plots
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Making candidate plots 
This section covers constructing candidate plots for generating new macro plots, and 
briefly addresses creation of CBI plots.  

NOTE: For in-depth information about using this tool for CBI, see Using the FFI GIS 
toolbar for CBI. 

To create new candidate plots: 

1. Click Make Candidate Plots in the FFI GIS toolbar. The Candidate Plots window 
opens.  

 

When the Candidate Plots window opens, a temporary layer called 
CandidatePlots_Temp is added to your map. This layer will disappear when you close 
the Candidate Plots form.    

2. Select your project unit in the Project Unit drop-down list. 
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3. The DNBR Layer is for use with CBI plot generation. If you are not creating CBI plots, 

you can leave this blank. To create CBI plots, set this drop-down to the layer 
containing your dNBR data.  

NOTE: For more information, see Using the FFI GIS toolbar for CBI.  

4. If you wish, you can add a Candidate plot prefix for use as a prefix to identify a 
specific set of candidate plots.  

The following sections discuss the Candidate Plots form tabs: 

o Random tab. 

o DBNR tab. 

o Selective tab. 

o Import tab. 

Candidate plots: Random tab 
The Random tab in the Candidate Plots window is used to create random candidate 
plots within a project unit. This is useful if you are installing new macro plots and need a 
set of random points to choose from.  

o Sample Count. The number of random sample points that you want to create. 

o Minimum spacing. The minimum distance in map units between sample points and 
from existing macro plots.  

o Polygon Layer. Optional. Points are restricted to polygons in a layer that you select. 
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Creating random plots 

In the example below, ten random plots with a minimum spacing of 100 meters will be 
created in the FOREST project unit within the perimeter of a burn unit. Their prefix will be 
Post. After you click Random in Project Unit, the program processes for a short time and 
then draws the points as fine red crosses. When the operation is complete, you can click 
Yes or No to keep or discard the points. 

 
You can use these plots to create a random candidate plot map to take into the field. 
To do this, export the candidate plots to a shapefile or print a map from your working FFI 
map document. You can also export the table associated with the candidate plots layer 
(see Add a plot layer for instructions on exporting a table). This table contains X,Y 
coordinates for each point as well as eight random azimuths. 

Importing candidate plots into FFI 

If you are not using a PDA, you can import the random plots that you selected for use 
while in the field directly into the Project Unit window in FFI after you return to the office. 
To do this: 

1. Be sure to save the candidate plots. 

2. Log into FFI. (If you were already logged into FFI, leave the program and start 
again.) 

3. In the FFI Project Management window, select the appropriate project unit. 

4. Select the Candidate Plots tab. Your candidate plots will be listed with the 
candidate plot prefix you selected. In this example, the prefix is Post. 
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NOTE: You can now use the Candidate Plots function buttons to edit the plot data, 
delete the plot, promote the candidate plot to a macro plot (at which point it will be 
listed in the tree view), or reject the candidate. 

5. Select a candidate of interest. In this example, Post_001 is selected. 

6. To promote the candidate plot to a macro plot, click Promote. The Macro Plot 
window opens.  

7. Add any other available data for the plot, and click Save. The new macro plot will 
be listed in the tree view. 
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Next: DNBR tab

Candidate plots: DNBR Tab 
The DNBR tab in the Candidate Plots window lets you select a DNBR layer and create 
random points within a range of values. You can create stratified samples by creating 
several sets of points with different prefixes. For example, you might use the prefix ‘low’ for 
a range of 25 - 255, ‘med’ for a range of 255 – 400, and ‘high’ for a range of 400 – 1000.  

For a more in-depth discussion of how to use the FFI GIS toolbar with DNBR and CBI 
plot generation, see Using the FFI GIS toolbar for CBI. 

o Minimum DNBR. The lowest value within the DNBR layer for acceptable sample 
sites.  

o Maximum DNBR. The highest value within the DNBR layer for acceptable sample 
sites.  

o Polygon Layer. Same functionality as in the Random tab; allows you to restrict the 
plot selection to a predefined polygon layer. 
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Creating random DNBR points  

In the example below, 25 random DNBR points with a minimum spacing of 50 meters, 
with a minimum DNBR of 25 and maximum of 255, will be created in the FOREST project 
unit within the perimeter of a burn unit. After you click Random in DNBR, the program 
processes for a short time and then draws the points as fine red crosses. When the 
operation is complete, you can click Yes or No to keep or discard the points. 

 

Importing candidate DNBR plots into FFI 

You can import the DNBR plots directly into the Project Unit window in FFI. To do this: 

1. Be sure to save the candidate DNBR points. 

2. Log into FFI. (If you were already logged into FFI, leave the program and start 
again.) 

3. In the FFI Project Management window, select the appropriate project unit. 

4. Select the Candidate Plots tab. Your candidate DNBR points will be listed with the 
candidate plot prefix you selected. In this example, the prefix is Low. 
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NOTE: You can now use the Candidate Plots function buttons to edit the plot data, 
delete the plot, promote the candidate plot to a macro plot (at which point it will be 
listed in the tree view), or reject the candidate. 

5. Select a candidate of interest. In this example, Low-016 is selected. 

6. To promote the candidate DNBR point to a macro plot, click Promote. The Macro 
Plot window opens.  

7. Add any other available data for the plot, and click Save. The new macro plot will 
be listed in the tree view. 

 48



 
Next: Selective tab

Candidate plots: Selective tab 
The Selective tab in the Candidate Plots window is used to interactively digitize 
candidate plots on the map. 

When you click the map with the candidate sites tool (circled on the screenshot), values 
are displayed for the cell itself and the eight neighboring cells as well as the minimum, 
mean, and maximum values for all nine cells. A fine red cross symbol (also circled on the 
screenshot) is drawn at the point where you clicked. The point is not added as a 
candidate plot until you click Keep This Point. When you use this tool, the ArcMap Identify 
Results window opens, which can be useful for monitoring values in other layers.  

For a more in-depth discussion of how to use the FFI GIS toolbar with DNBR and CBI 
plot generation, see Using the FFI GIS toolbar for CBI and Selective sampling. 

o Center on Cell checkbox. When this box is checked, digitized points will be placed 
exactly in the center of the DNBR cell on which they fall. 
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o Keep This Point button. The point is not added to the candidate plots layer until you 
click this button. 

 
 Next: Import tab

Candidate plots: Import tab 
The Import tab in the Candidate Plots window lets you import sample plots from a point 
layer in the map. The DNBR values are captured and the points are numbered with the 
prefix that you specify.  
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Next: Deleting candidate plots
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Deleting candidate plots 
To delete unneeded candidate plots from a project unit: 

1. Select the plot in Arc Map using the Select Features tool (shown here circled in the 
ArcMap Tools toolbar) or by some other method in Arc Map.  

 
2. Click Delete Selected to delete the selected candidate plot from the project unit. 

 Confirm the deletion as shown. 

 
3. To delete all candidate sites from the current project unit, click Delete All. Confirm 

the deletion as shown. 

 

NOTE: Deleting candidate plots will not affect macro plots that were generated from 
them. 

See also: Adjusting dNBR range
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Adjusting dNBR range 
The Adjust DNBR Range tool in the FFI GIS toolbar allows you to visually determine 
thresholds between severity classes. The selected layer must be an integer grid with a 
classified legend. This topic is discussed in detail in the section Using the FFI GIS toolbar for 
CBI. 

See also Displaying a tree map
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Displaying a tree map 
The Display Tree Map menu item in the FFI GIS toolbar opens a form with a map control 
for printing tree maps.  

This form reads the database directly; it has no relationship to the layers in the map. 
Only trees that have been saved as subsamples are mapped.  

 
o Project Unit drop-down. Use this option to filter the macro plots.  

o Macro Plot drop-down. Select a plot to see its map.  

o Date drop-down. Indicates the date that the macro plot was created. 
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o Plot Boundary text boxes. FFI does not populate the plot dimensions. Enter the 
minimum and maximum local plot coordinates in relation to the plot origin to 
control the area shown by the map and the blue box around each map.  

o Add to Map Document button. This adds a new dataframe to the current map 
document with the tree map. Look for it at the bottom of the ArcMap tree view. 
Right-click the new dataframe and select Activate to view it in the map window. 
Note that this dataframe shows only trees on the most recent tree map because it 
is driven by a static table in the personal geodatabase. 

 
o Print button. Sends the map to the default printer.  

o Write PDF button. Creates a PDF of the map in the administrative unit folder under 
FFI\{mypark}\Documents\PDFs named with the plot name and the date.  

Return to Using the FFI GIS toolbar
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Using the FFI GIS toolbar for CBI 
The FFI GIS toolbar can help you prepare to do CBI plots. The toolbar lets you visually 
determine preliminary thresholds between severity classes and select potential CBI plot 
locations that are stratified by severity class.  

This section addresses: 

o Adjusting DNBR range 

o Stratified sampling 
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Adjusting DNBR range 
The Adjust DNBR Range tool allows you to visually determine thresholds between severity 
classes. The selected layer must be an integer grid with a classified legend. If you are 
unsure whether your dNBR layer is an integer grid, consult your local GIS specialist. 

The tool can be used in a variety of ways. The example in this section shows one way to 
use this tool to determine severity class thresholds. The method is based on the 
Landscape Assessment documentation Remote Sensing of Burn Severity: The Normalized 
Burn Ratio (Key & Benson, 2004). 

Set legend to Classified 
The Adjust Legend tool requires that the legend be classified and that it have exactly 
seven severity classes. 

1. To set the legend to Classified, double-click on the name of your dNBR layer in the 
tree view. This brings up the Layer Properties dialog. 

 
2. Click on the Symbology tab and select Classified under Show at the left side of the 

form. 
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3. In the Classes drop-down list, select '7' as the number of severity classes for your 
legend. 

4. Double-click on the colored Symbol box for each class to set the legend colors. 
Select a color for each class. 

Next:  Identify unburned areas

Identifying unburned areas 
A good first step is to identify unburned areas and areas of enhanced regrowth. 
Enhanced regrowth refers to areas, such as some herbaceous communities, that have 
increased post-fire productivity. These areas have strongly negative dNBR values. 
Enhanced regrowth is often classified as areas with dNBR values less than -100.  Unburned 
areas normally fall into the range between about -100 to 99 and should form a clear 
perimeter around a burn. 

To identify unburned areas: 

1. First, in the Layer Properties dialog, set the color for the Enhanced Low and 
Enhanced High to No Color.  

2. Click OK to close the dialog box and then open the Adjust DNBR Range tool in the 
FFI GIS toolbar. 

3. In the Adjust legend range box that opens, set the upper bound for both 
Enhanced Low and Unburned classes to -100.  To simplify the image, you may also 
want to set the values for Low Severity, Low-Moderate, Moderate-High, and High 
Severity all to your highest dNBR value (1081 in this example). At this point, most of 
your dNBR layer will appear as Low Severity. 
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3. Next, slowly increase the upper limit of the Unburned class. As you do this, 
Unburned colored areas will begin to appear around the perimeter of the burn. 
These will be scattered at first and then gradually form clumps around the 
perimeter of the burn. 

4. When the burn area is clearly delimited, typically at a value around 100, you have 
reached the upper threshold for unburned dNBR values. Record this value.  

Ideally, unburned pixels should be concentrated along the perimeter of the burn, but 
this is not always the case, as you can see below.  

 
Next:  Identify classes

Identifying severity classes 

High-severity areas 

Next, it is useful to establish the lower threshold for high-severity areas. To do this, slowly 
decrease the lower limit of the High Severity class (the same as the upper limit for the 
Moderate-High Severity class). High Severity colored pixels should appear in a few 
scattered locations and then begin to form clumps. After these patches fill in, but before 
they begin to coalesce, note your dNBR value. If it is somewhere in the range of 600 to 
750, it represents the lower threshold of the high-severity burn class. 
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Remaining classes 

Finally, separate the remaining pixels that fall between unburned and high severity into 
low, moderate-low, and moderate-high classes. You can do this based on Table LA-2 
from Key & Benson, 2004. 
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Next: Map classes

Map classes 
To depict classes in your map, return to the Symbology tab in the Layer Properties form. 

Select Classification and set the number of classes at 6. Click the Classify button to set 
your threshold values. Under Break Values, you can enter your thresholds directly. The first 
(lowest) threshold value should be the lower threshold for unburned (in most cases this is -
100).  

The next threshold value should be the upper threshold for unburned/the lower threshold 
for lower severity. Continue in this fashion so that each break point between severity 
classes is recorded in the Break Values section of the Classification form.  

 
Finally, you can recolor the symbol for each class as desired.  
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See also: Stratified sampling
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Stratified sampling for CBI 
The FFI GIS toolbar allows you to quickly and easily create candidate plots for CBI 
sampling within each burn severity class. The following example shows the step-by-step 
process for creating candidate plots for CBI. 

Random from DNBR   
Using the DNBR tab on the Candidate Plots form in the FFI GIS toolbar is one way to 
create random sample points for CBI plots. 

1. First, select the project unit in the Project Unit drop-down list. 

2. Set DNBR Layer to the DNBR layer in your map. 

3. Under Candidate plot prefix, enter the name of the severity class for which you are 
creating samples. 

4. Enter the number of candidate points you would like to create, the desired 
spacing between candidate plots, and the range of dNBR values that you would 
like the candidate plots to fall within. 

You can select from the Polygon Layer drop-down list to define a polygon that all 
candidate sites will fall within. In the example below, the burn perimeter is used.   

When you click Random in DNBR, random candidate sites will be created according the 
parameters that you set. In the example below, 20 points are created in areas of dNBR 
ranging from 25 to 225 that are at least 50 meters apart and that fall within the burn 
perimeter.  

Repeat this process for each severity class, resetting the Candidate plot prefix and the 
Minimum and Maximum dNBR values as appropriate. 
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Next: Selective sampling

Selective sampling 
The Selective tab in the Candidate Plots form in the FFI GIS toolbar allows you a greater 
degree of control in locating potential CBI plots. This tab lets you place plots in areas that 
are accessible and have relatively homogeneous dNBR values. 

1. First, select the project unit in the Project Unit drop-down list. 

2. Set DNBR Layer to the dNBR layer in your map. 

3. Under Candidate plot prefix, enter the name of the severity class that you are 
creating samples for. 

4. Click the Selective tab. 

You can now use the tool on this tab to select sites for CBI plots. When you click a 
location on the map, the DNBR neighbor values shows the dNBR value of that pixel and 
its eight neighbors. The Min, Mean, and Max boxes show the minimum, maximum, and 
average values of all nine cells. 

The ArcMap Identify Results dialog will also appear, and you can use that to display 
another parameter of interest, such as the slope or vegetation type at the location you 
selected. When you find a site that is relatively homogenous and meets your 
requirements in terms of accessibility (proximity to roads, slope, etc.), click Keep This Point 
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and the point will be added to your CandidatePlots_temp layer. The Center on Cell 
checkbox will place a selected point in the center of the cell that it falls in. 

 
Next: Field sampling

Field sampling 
Once you have created the desired number of sample plots in each severity class, you 
can create a map of these plots for field sampling directly in your working FFI map 
document, or you can export the CandidatePlots layer to a shapefile and create a 
separate field sampling map. You can also export a table from your CandidatePlots layer 
or shapefile and import the candidate site coordinates directly from the table into your 
GPS unit.  

If you are planning to collect CBI data in the field using a PDA, you must create your 
macro plots before you go to the field. Since you won’t know which CBI plots you’ll be 
using until you visit and evaluate the candidate plots, you should add "placeholder” 
macro plots to the PDA. You can add the desired number of “placeholder” plots and 
then add the coordinate and other plot data into FFI after you return from the field. 

Return to Using the FFI GIS toolbar for CBI 
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